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Welcome to the latest edition of my monthly Final Cut Studio newsletter for February, 2010.

The goal of this newsletter is to provide information helpful to the interested user 
of Final Cut Pro. This newsletter publishes each month, past issues are available 
in my store. All software references are to Final Cut Studio 2 unless otherwise 
noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, the latest industry news, and over 450 articles and tutorials to help 
you get the most out of Final Cut!

And, if you haven't already, please subsubcribe to this free monthly newsletter 
here. 
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�●     Larry on Facebook
�●     Larry on Twitter
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�●     Larry Jordan's Blog 
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WELCOME

It's the end of February and I've decided winter is on the wane... recent snowstorms not 
withstanding. My hope is that with the return of spring we'll start to see an increase in business 
as well. Well, at least that's my hope. Too much work is always better than not enough.

February has been a busy month for me. I just returned from a two-week seminar trip to 
Scotland, England, and Ireland. I love doing seminars, but they are also a challenge for me. 
Some people present the same seminars over and over again. For some reason, I can't do that. I 
try to put something new in every seminar I teach. For this trip, I created new content for seven 
new seminars. I'm hoping to share much of that with you over the next several newsletters.

Also, I wanted to apologize for a workflow breakdown over here. For the first five years of this 
newsletter, as each new issue was released, we would take the articles from the previous issue 
and post them to our website. About six months ago, the person who handled that for us left. 



Since then, we've tried to continue this process with two other people, neither of whom have 
worked out. Consequently, I have a huge backlog of articles that we are trying to get posted 
online. We will get this fixed, but it is taking a lot longer than I ever expected. In the meantime, 
you can find all newsletter back-issues in our store. Again, my apologies.

With NAB just around the corner, the Digital Production Buzz will covering NAB like a blanket. (I'll 
have more on that next month.) However, we can use some help. Email us if you are interested 
in volunteering some time. 

Our industry continues to be in a period of dynamic change. I look forward to sharing what I learn 
about it each month in this newsletter.
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QUICK NOTE: HANDS-ON ONE-DAY SEMINAR  
ON VIDEO COMPRESSION

In partnership with DVCreators.net I'm doing a one-day hands-on seminar about Video 
Compression this Saturday, March 6. We have room for ten people. Click here to learn more.
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UPDATE ON MOCHA FROM IMAGINEER SYSTEMS 

In the December issue I did an extensive review of Imagineer 
System's mocha. In brief, I thought the product did things that could 
not be done by either Final Cut or Motion, but it had a very hard to 
learn and non-intuitive interface, compounded by on-line training 
and documentation that made the product very difficult for users 
new to motion effects to learn.

This review generated a lot of comment from readers, and from the folks at Imagineer Systems. 
Based on that review, and other user comments, they have redone a lot of their on-line training 
targeted at the Final Cut Pro user and are working on a new version of the program to be 
announced soon. In addition, since they are based in the UK, they invited me to meet with their 
lead trainer on my recent trip to London to learn how to use the product better.

During our visit, I had time to interview Martin Brennand about mocha. Martin is the chief trainer 
for mocha. You can listen to our audio interview here. After talking with Martin, and reading 
comments from Ross Shain at Imagineer, I learned something that I wanted to share with you. 

http://www.larryjordan.biz/app_bin/Store/catalog/index.php?cPath=29_32
mailto:debbie@larryjordan.biz?subject=I want to help at NAB
http://www.dvcreators.net/events
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http://www.digitalproductionbuzz.com/BuZZ_Audio/Brennand_M_Buzz_100218.mp3


Based on Ross Shain's feedback from the article I made a mistake when my hands covered the 
corners of the card I wanted to track. Since the card was white, and the corners were sometimes 
visible and sometimes not, mocha didn't have enough consistent information to know what to 
track.

So, I went back into the studio and reshot the video with a new card and holding it differently. I 
wanted to demo mocha as part of my seminars in the UK, so I created what I thought was better 
video.

However, I still screwed up. When I met Martin, he told me that motion trackers like to track 
something with texture, or contrast, in the object being tracked. Because I used a plain what 
card, it was very hard for mocha to find specific elements within the object it could grab and 



track. 

Next time, Martin suggests holding an actual sign with text, or adding marks to the surface that 
could be used as tracking dots; moving an object with no detail is very difficult to track.

You can find more about how to shoot for motion tracking in this video tutorial on the Imagineer 
website.

I want to thank the folks at Imagineer Systems for their comments to my review, and for marking 
Martin available during my visit. I'm also looking forward to seeing what's new in the next version.

However, my experience also illustrates something the rest of us need to keep in mind. If you are 
thinking of doing fancy effects in post-production -- TEST YOUR IDEAS before going into 
production. I've learned I need to be careful selecting the object I use to generate the track, 
where I hold my hands, and the difference between the object (in this case the color of a card) 
and the background (the color of my shirt).

This has been an interesting experience and I suspect there still plenty more to learn.
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THREE REMAINING SEMINARS: 
WASHINGTON DC, VANCOUVER BC, AND LOS ANGELES

My latest PowerUP with Final Cut seminar tour is winding down -- with 
only three cities left:

* March 3 - Washington DC -- only two seats left! 
* March 9 - Vancouver BC -- fifteen seats left 
* March 16 - Los Angeles -- plenty of room

If you are looking for ways to improve your skills, trouble-shoot your 
system, discover plug-ins to make your life easier, or meet other editors, 

my PowerUP with Final Cut Studio seminars are the place to be.

Best of all, the price is only $99 for 8-hours of training - a great day at a great price.

Click here to see the agenda and to register.

We've been getting rave reviews and helping lots of editors solve nagging problems. It would be 
great to see you at one of these events. Thanks to the folks at SmartSound and Red Giant 
Software for making these seminars possible. 
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TECHNIQUE: PLURALEYES PLUG-IN FOR FINAL CUT PRO 

If you do a lot of multicam work, you need to check into PluralEyes, 
by Singular Software. I first learned of this software in a 

http://www.imagineersystems.com/support/tutorials/movies/How_to_Shoot_Tracking
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conversation with Roz McNulty. Then, the developer Bruce Sharpe 
called to tell me about it. Let me give you a couple of examples 
about why this software can be very, very helpful. 

Multiclips first showed up in Final Cut Pro 5 and they allow you to synchronize and view multiple 
clips at the same time. Generally, images you want to synch as multiclips are recorded by 
multiple cameras at the same time. (By the way, the images in this article were provided by 
Singular Software.)

The important thing to keep in mind with multiclips is that every clip in a multiclip needs to 
contain continuous timecode, as well as use the same compression codec, image size, and 
frame rate. As well, when you use Final Cut Pro to build your multiclips, you can only synch them 
five ways; using a common: 

* In 
* Out 
* Timecode 
* Aux timecode track 1 
* Aux timecode track 2

Many times, for professional productions, this is fine. A clapper slate or camera flash is used to 
set the In, or feeding all cameras common timecode are very common. However, what happens 
if every camera is running different timecodes and you don't have a good In or Out point? 

Yup. You have a problem. This is where PluralEyes almost performs magic.

TECHNIQUE #1 - SOMETHING SIMPLE 



For instance, here three cameras are edited to the timeline. Notice that each camera includes 
synced audio. Clips are only put into the timeline, nothing has been done to align them. 

Note: I've created a sequence in the Browser called PluralEyes. This MUST be 
the name of the sequence for PluralEyes to work and you can only have one 
project open at a time that contains a PluralEyes sequence.

Now, go to the Applications folder and open PluralEyes. It automatically looks into all open FCP 
project and finds the PluralEyes sequence.



It then displays a dialog asking if you want to Sync the clips in the Timeline - that is, to arrange 
them in the correct order so that the action they contain matches, or create a multiclip.

In this case, I want to create a multiclip to edit all three angles simultaneously, so I click 
Multiclip. 

Here's where the magic starts. PluralEyes listens to the audio in each clip and syncs the clips by 
aligning the audio. Once the clips are in sync, it creates a multiclip and loads it into the Browser.

Important note: In order for this to work, you must record audio on every camera; 
even it is only using the camera mike. 

Ta-DAH! 

Note: This is a great technique to use for working with DSLR cameras, which are 
notorious for their poor sound quality. Record audio on the DSLR using the 
camera mike, and record good audio on your external audio gear. Load both files 
into Final Cut and sync using PluralEyes. No need for matching timecode or 
worrying that your DSLR audio sounds awful. 

TECHNIQUE #2 - AN IMPOSSIBLE SITUATION 



Here we have what can most charitably be called a complete mess. One camera recorded the 
entire song. The other two cameras were recording snatches of the piece, with constant stops 
and starts. No matching timecode, in fact, a total break in timecode.

Sigh... When I was very young, I once shot something like this. It took years for my crew to stop 
teasing me about it. Because even if editing is possible, it takes forever to match up all the clips 
to the music.

Open the PluralEyes application. In this case, we want to sync the clips to the Timeline. 
(Because there are breaks in timecode, creating a multiclip is not possible.) However, let's give 
the application some help - click the Change button. 



The Change button allows us to tell it that all clips are in chronological order -- a reasonable 
assumption, since we are shooting a performance. And by checking Level Audio, we are telling 
the application to adjust audio levels during its analysis so it can hear the audio better. This does 
NOT affect the final audio in the Timeline.

Click OK to accept the Sync Options, then click Sync to begin the entire process. 

When I click Sync, the software starts comparing the audio of every clip to every other clip.

In about 90 seconds, in this example, look what PluralEyes did -- it aligned every clip, on every 
track, so that the audio matched. Since the video is synced to the audio, all the video clips are 



now aligned and synched as well!!

I can guarantee that if I had to do this manually, it would take me a LOT longer than 90 seconds.

I first discovered PluralEyes when Bruce Sharpe, the CEO of Singular Software called me and 
asked if I could demo this at a recent Final Cut Pro SuperMeet. Once I saw what it did, and 
picked my jaw up off the floor, I've been showing this at my seminars around the world.

I thought you might like to see it as well.
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DIGITAL PRODUCTION BUZZ COVERING THE NAB SHOW 2010

Just like last year, our podcast - the Digital Production BuZZ - will be 
extensively covering the NAB Show 2010 from Las Vegas!

We will be producing seven one-hour Digital Production BuZZ show special reports - one each 
day - highlighting the best of NAB. As well, we will be producing hourly NAB Show News Briefs 
during the entire show to cover the breaking news at NAB.

And we could use some help. If you'd like to volunteer some time at the show, we need 
producers, reporters, audio editors, production staff. Basically, we are building a radio news 
room for the life of the show.

If you would like to be part of this effort, and are already planning to be at NAB, send an email to 
Debbie Price, our Convention Manager. She will let you know what we need and how you can fit 
in.

We really need the help and I'd love to work with you.
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TECHNIQUE: GOING GREEN -- COLOR BARS OVER AUDIO CLIPS

I was getting my computer ready to do a presentation recently at the LA Final Cut User Group, 
when Andrew Balis walked over and asked: "Larry, I see you're using non-standard audio in 
your sequence."

I gave him a blank look and asked: "What?"

http://www.nabshow.com/
http://www.digitalproductionbuzz.com/
mailto:Debbie@larryjordan.biz?subject=I want to help at NAB!


Andrew said: "See that green line at the top of your audio clip in the Timeline? It means that the 
sample rate of your audio clip does not match the sequence settings of your Timeline."

Well, clearly, I have not been paying attention, because I've seen those green lines for years and 
never, once, figured they meant anything.

But I know that this audio was recorded at 44.1 kHZ, while the Timeline is set for 48 kHz, so I 
went to Sequence > Settings > General and changed the sample rate in the lower right corner 
to 44.1 kHz and... POOF! No green lines!



OK. Time for some homework. 

Although FCP allows both 44.1 kHz and 48 kHz audio on the timeline at the same time and plays 
them both in real-time, when it comes time to output or export, any audio that doesn't match your 
sequence settings gets rendered to match. This is not necessarily evil, but it can be avoided and 
takes time to render. And, for sample rates lower than 44.1 kHz, this re-rendering can affect 
quality.

In general, you want your sequence settings to match the sample rate of the majority of your 
audio. In this case, my entire sequence had music that was recorded at 44.1 kHz, so it made no 
sense to have my sequence settings at 48 kHz. Podcasts and pre-recorded music are other 
examples of 44.1 kHz audio. 

Thanks, Andrew, for pointing this out. I'm now paying much closer attention to little green lines.
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TECHNIQUE: NESTING IN FINAL CUT PRO 

Nesting is the process of placing one, or more, sequences into another sequence in the 
Timeline. Nesting has been a part of Final Cut Pro for many years, but is often not well 
understood. Since this feature is both powerful and useful I wanted to talk about it with you today.

The last time I wrote about nests was in December, 2008, when I showed how to use nests to 
provide clean dissolves between two chroma-key shots. (You can read the article here.)

This time, I want to talk about nests more generally. There are four principle reasons to use 
nests:

1. The create a master sequence (like a show) from a group of sequences (such 
as individual scenes).

2. To a apply a single filter, or motion effect, to a group of clips in such a way that 
when you change the filter, or motion, settings, it changes across the entire range 
of clips.

http://www.larryjordan.biz/articles/lj_dissolves_betw_chroma_keys.html


3. To process a motion effect for a clip before a filter is applied to it.

4. To create image sizes for effects that are different, and generally larger, than 
your sequence image size.

This article talks about the first three options - the last deserves its own article in the future.

There are two ways to edit a sequence from the Browser into the Timeline:

1. Drag it into the Timeline as you would drag a clip.

2. Drag it into the Viewer, if necessary, set an In or Out, then edit it to the timeline 
as you would a clip. I generally edit sequences via the Viewer.

Note: A benefit to setting an In or Out in a sequence before editing it to the 
Timeline is that if you change the duration of the clips inside the sequence, the 
duration of the nested sequence does not change.

In addition, you can create a nest within the Timeline by selecting a clip or group of clips, then 
choosing Sequence > Nest Items (or typing Option+C).

#1 SHOW MASTER

Many times, in an effort to keep sequences manageable, longer programs and movies are edited 
such that each scene is a sequence, rather than creating the entire film in a single sequence. 
This allows you to organize very complex projects more easily, navigate within a sequence 
faster, and keeps a project from become overwhelming.

However, when the time comes to create a show master, you need to consolidate all these 
different sequences into one. Nesting makes that easy. 

For instance, here, I have created a sequence containing a program composed of four separate 
sequences. Each sequence is an Act, which I edited individually. I added a blank section 
between each act to allow for commercial breaks. Notice, also, at the end of the sequence I 
added a slug. Slugs are audio and video black. What the slug does is tell FCP to play black at 
the end of the sequence for the duration of the slug. 



You create slugs from the Generator menu in the lower right corner of the Viewer.

Note: When there is a gap between clips, FCP automatically inserts audio/video 
black during playback. But at the end of the sequence, FCP will stop, unless you 
add a slug. I generally add 60-seconds of black at the end of any sequence that 
will ultimately be laid back to video tape. If the sequence is for the web, I often add 
one second of black to be sure my final shot properly fades to black

The nice thing about using nests to create a show master is that no matter how messy your 
individual sequences are, your show master remains nice and clean and organized. This makes 
it easy to get timings, and make sure you've included all the scenes in your show.

If you are laying back to tape, you may also want to include color bars and tone, along with a 
slate at the top of the show. The industry accepted standard is 60-seconds of bars and tone, 10-
seconds of black, 10-seconds of slate, 10-seconds of black, then the start of your program.

You can find bars and tone, along with a full screen text clip you can modify for the slate, in the 
Generator menu at the bottom right corner of the Viewer window.

DECONSTRUCTING A NEST

Sometimes, you want to add the contents of a sequence into another sequence, but convert 
them back into individual clips, not as a nest.



An easy way to do this is to drag the sequence from the Browser to the Timeline, then, as your 
mouse enters the Timeline window, hold down the Command key. This converts (or 
deconstructs) your nest back into all its individual clips. 

Pay attention to the shape of your cursor as you drag, to determine if you are doing an insert edit 
(arrow points right) or an overlay edit (arrow points down) with the clips.

#2 APPLYING ONE FILTER TO MULTIPLE CLIPS

Another common use of nests is to apply a filter to a group of clips. Now, you could do this easily 
without using a nest by selecting the clips and applying the filter to the selection. 

The problem with this is that if you need to change the filter settings, you need to do so one clip 
at a time. The benefit of this approach is that you can change the filter slightly for each clip.

The benefit to using a nest is that you essentially have a single "master" filter whose settings 
apply to all the selected clips. You can then adjust the effect for all those clips just by changing 
one filter. The limitation to using a nest is that the filter settings must be the same for each clip.

Note: I keep using the word "filter." However, this technique works for any 
combination of filter or motion effects.

Common situations where using a nest can be very helpful is in color correcting a group of clips 
to achieve a certain look, sizing a group of clips to all be the same size for a background effect, 
or adding a blur filter to make the text above the blurred clips more readable. There are many 
other ways you can use this technique, as well.



Here, for instance, I've selected three clips.

Go to Sequence > Nest items to convert the clips into a nest. (Remember, a nest is just another 
name for a sequence contained in another sequence.)



In this dialog, I named by clips "Blurred background clips" so I would know what I was doing with 
the nest. (You can use any name you want as long as it helps you to stay organized.)

Notice how the group of clips has been replaced by a slightly different color for the clip. This is a 
nest -- a sequence contained inside another sequence.

To see the clips contained in a nest, double-click the nest. It opens as a new tab in the Timeline. 
to make changes to the nest, open it and change the clips inside, as you would any other 
sequence. Your changes are reflected automatically back into the nest.



Select the nested sequence in the timeline, not the clips contained in the nest, and apply an 
effect. In this case, I'm applying Effects > Video Filters > Blur > Gaussian Blur.

Here's the tricky part. To adjust the filter, Option+double-click the nested sequence in the 
Timeline to open it into the Viewer. If you just double-click it, you'll open the nest in the Timeline. 
We need to adjust the filter setting, which means we need to open the sequence in the Viewer.

Once you have the nest open in the Viewer, you can adjust effects as you would any other clip.

Repeat this process -- Option-double-click to open a nest into the Viewer -- whenever you need 
to adjust your effect settings until you have the effect you want.

#3 - CHANGE PROCESSING ORDER

When I was being trained as an instructor for Final Cut Pro 3, I was shown this next trick. It is still 
be best way to illustrate this problem.

You may not have reflected on this, but Final Cut Pro has a very definite method when it is 
creating effects. First, it processes anything in the Controls tab. Then, it starts at the top of the 



filter tab and moves down until all filters have been processed, one after the other. Finally, it 
moves to the Motion tab, starting with the top setting and moving down.

Most of the time, this processing order is fine. But, sometimes, it can trip you up. Here's an 
example.

Let's say you want to create a clip that is both reduced in size and blurred. Normally, you would 
apply a Gaussian Blur filter, and reduce the scale of the clip in the Motion tab; in this case, I used 
50%.

The problem is that while the center of the clip is blurred, the edges are sharp.

Hmmm... this is not what we want. I want the entire clip to be blurred, including the edges.

However, since FCP processes all filters first, it starts by blurring the clip. When it then goes to 
the Motion tab to reduce the size of the clip, all the blurring is complete, which means the edges 
remain unblurred.

Hmmm... this is not what I want. So, to fix this, we need FCP to first reduce the size of the clip, 
then blur the clip.

Here's how.



Double-click a clip to load it into the Viewer and change its size. In this case, I'm scaling it to 50%.



Next, select the Timeline and be sure your clip is still selected, then choose Sequence > Nest 
Items.

Give your sequence a name that tells you want you are doing to the clip and click OK.



  
  
  
  
  
  
  
  
  
  

In the Timeline (notice the nest is now a slightly different color blue) select the nested clip. Apply 
the Effects > Video Filters > Blur > Gaussian Blur filter.

Option-double-click the nest to load it up into the Viewer and adjust the Blur settings. In this 
case, I used a setting of 40 so you can really see the effect. Notice that both the clip and the 
edges are blurred.

Cool.

NEST NOTES

There are a few things to note about nests:

1. Audio may not properly transfer from the clips inside the nest to the sequence 
containing the nest. If that happens to you, select the nest in the Timeline and 
choose Sequence > Render Only > Mixdown to remix your audio.

2. Nests are dynamic. Changes you make to the clips in the nest are automatically 
reflected in the sequence containing the nest.

3. If you set an In or an Out in a nest in the Viewer before editing it to the Timeline, 
changing the duration of the clips in a nest won't change the duration of the nested 
sequence.

4. However, if you drag a sequence from the Browser to the Timeline, the nest 
become dynamic. If you shorten the clips in a nest, the sequence containing the 
nest will shorten. This would be similar to rippling a clip. HOWEVER, if you 
lengthen the clips in a nest and the nest is followed by another clip, the length of 
the sequence containing the nest does not change. FCP does this to prevent 
knocking downstream clips out of sync when the duration of a nest changes. If you 
want to lengthen a nest who's duration has changed, you need to do so manually 
by dragging the right edge of the nested sequence.

5. Render files are stored in the sequence. So, if you render the clips inside a 



nest, you will need to re-render the sequence once you nest it. Render files are 
stored inside the sequence that contains the nest, not with the nest itself.

FINAL THOUGHTS

Nests are very powerful tools you can use to organize your sequences or easily create effects 
that would be very hard to do any other way.

UPDATE - FEB. 28, 2010

Loren Miller writes:

About nests-- remind folks they should *never* cut into a nest-- it duplicates the 
contents and swells memory requirements for the sequence. (I checked with the 
team about this to confirm it). Every time you slice into a nest-- thinking it's a quick 
way to extract an undesired chunk in the middle-- you create two containers of the 
same clips. I've called this the Sorcerer's NestMess Syndrome-- after Mickey as 
the Apprentice in FANTASIA, duplicating brooms with buckets ad infinitum. 

First came to my attention several versions ago when a client presented a feature 
rough cut with many slices in nests-- and we were getting regular Out of Memory 
alerts!

Larry replies: Thanks, Loren, will do. 
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NAKED MICE NEED NICE RUGS

Yes, it's true. I've learned that some computer mice are being 
forced to slide around on hard, cold tables. Poor mice. However, a 
solution is close at hand.

I've created the latest in mouse-designer fashion -- a warm, toasty, mouse-pad covered with over 
40 Final Cut Pro keyboard shortcuts.

So, now your mouse gets to keep its red laser nice and warm on these winter nights, and you get 
some of the most useful, yet little-known, keyboard shortcuts all assembled in one easy-to-find 
place.

This mouse-pad is currently warming the little feet of the mice of some of the most famous 
filmmakers in the world. (No, I can't tell you who, but if I did, you'd be impressed.)

Newly redesigned for 2010, this mouse-pad had all the conveniences - a mouse-friendly top 
surface, a grip-the-table-to-death bottom surface, a thick-and-bendy middle, lots of interesting 



stuff to read, and a cute design that will make your mouse feel especially loved.

What's not to like? (You purchased some clothes for yourself recently... isn't it time to do the 
same thing for your mouse?) 

Plus, it has a GREAT low price -- less than $10!  
Support your mouse! Buy your copy today - click here! 
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TECHNIQUE - DIGITAL ANARCHY BEAUTY BOX

You know the drill. The client didn't have the money for makeup when they were shooting the 
video, then is horrified to discover in post that their star/kid/sweetie has a humongous zit that 
spoils all the close-ups of the video they dumped in your lap to edit.

In the past, I've mentioned how you can use Sheffield Softworks Electronic Makeup Artist to try 
to fix these problems.

Recently, Digital Anarchy released a new package called Beauty Box that simplifies the work 
and improves the results. I was talking with Jim Tierney, the CEO of Digital Anarchy, about this 
recently and he said that the challenge is to smooth the skin (which basically means to blur it) 
without blurring details like hair or eyes.

In a bit more technical terms, they are using skin recognition technology to create a traveling 
matte which selectively blurs the skin, but nothing else, by the amount you specify.

I told Jim that I was very interested in showing this plug-in on my UK tour, so he sent me a copy. 
Installation was easy and using it is straight-forward.

Note: Whenever you install new plug-gins you want to be sure Final Cut Pro is not 
running. This is because FCP only looks for new plug-ins when it starts up. 

After installation, I started Final Cut and edited a clip to the Timeline. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162
http://www.sheffieldsoftworks.com/
http://www.digitalanarchy.com/


Here' a detail of our model's face. When this was shot, we didn't use any make-up, just a matte 
gel to decrease light reflections. Notice the texture in her skin, and a few freckles scattered 
about. She definitely doesn't look bad, but we can improve this.

I selected the clip and applied the Beauty Box filter (Effects > Video Filters > Digital Anarchy > 
Beauty Box), as you would apply any filter to a clip. 



The default settings for the filter are pretty good, they tend to minimize excess edge detail that 
lower-end cameras put into the image and soften skin tones a bit in general. However, in this 
case, I wanted to give her skin more of a "made-up model" look.

To do this, I scrolled down in the filter dialog to where it says "Dark Color." This represents the 
darker portion of skin color that you want to soften, just as "Light Color" represents the lighter 
portion of skin. What you are doing, essentially, is setting the parameters of what the filter uses 
as the range of skin colors to soften.

Using the eyedropper, I clicked one of the darker freckles above her left eye. 

Moving up, I increased the Smoothing Amount from its default of 25 to 50. This increased overall 
softening. Then, I increased the Smoothing Radius to 15. This increased the blending between 
colors to minimize color changes in the face.



Note: There are more controls in the filter if you feel the need to tweak, but most 
of the time you won't need to.

The nice thing about this filter is that once you have it set, it will track the movements of the face, 
so that as long as your lighting remains relatively constant, you won't need to tweak the filter for 
each frame of the shot.

Here's a comparison of the differences between the filter off (left) and on (right). I was very 



impressed at both the results I was able to achieve and the speed with which I got there. 

Very cool.
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ALL MY 2009 NEWSLETTERS NOW AVAILABLE ONLINE

Missed one of my newsletters last year? Well, not to worry. Now you can 
get them all!

All twelve newsletters published during 2009 have been gathered into 
one place -- 527 pages of Final Cut Studio goodies. (This is almost 
TWICE the pages we wrote in 2008!)

Each month's issue is a fully-searchable PDF, with all links intact, so you 
can refer to each issue over and over again. This collection contains 
hundreds of ideas you can put to work today to save time, save money, and create better 
projects.

Selected 2009 Headlines

�●     Jan - Blu-ray Disc Special Report and Multi-channel Audio Output from FCP
�●     Feb. - Customing Keyboard Shortcuts and World's Fastest Shortcut Finder
�●     Mar - Review: Telestream Pipeline and Adding Reverb to an Audio Clip
�●     Apr - Editing Sound and Understanding Aspect Ratios
�●     May - Using the Soundtrack Pro Limiter Filter and Creating a Glowing Lantern Effect
�●     Jun - Snow Leopard Launches and Using Submixes in Soundtrack Pro
�●     Jul - Understanding RAID Levels and Fixing Out of Sync Audio
�●     Aug - Final Cut Studio (3) is Released and Interview with Apple's Richard Townhill
�●     Sep - Review Sheffield Softworks Retouching Filters and Setting Capture Scratch Disks
�●     Oct - Apple Announces iFrame and DroboPro and Euphonix Reviews
�●     Nov - Love Letter to LiveType and Creating a Vignette and Generating a Gradient
�●     Dec - Review Imagineer Systems Mocha and TONS of Reader Mail

Each issue is filled with information you can't get anywhere else. And now, everything is 
gathered all into one place!

Format: 12 PDFs stored in a ZIP file 
Pages: 527 
Price: $19.99

Click here to buy your collection today!

Looking for a bit of history? Here are all my 2008 newsletters.
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TECHNIQUE - TRANSCRIPTIZE

I am almost never present during the birth of a new piece of software, 

http://www.larryjordan.biz/nxlttrs.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=163
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=91
http://www.assistedediting.com/Transcriptize/
http://www.assistedediting.com/Transcriptize/


but in this case, it happened at our company Christmas Party, last 
December. 

Philip Hodgetts, Greg Clarke, both from Intelligent Assistant, and I 
were standing around talking technology, codecs, and software -- you 
know, the usual subjects at a Christmas Party -- at least for me.

Anyway, I mentioned that when I was writing my book on Adobe 
Production Premium, I was frustrated by the limitations of their 
Speech-to-Text Transcriptions. Specifically, there was no way to get 
them out of Adobe Soundbooth or Premiere except as XML 

documents, which makes these transcripts virtually useless outside of the Adobe environment.

Greg got a reflective look in his eye and said, "That shouldn't be too hard to fix." And 
Transcriptize was born.

There have been a lot of arguments on the net that the transcripts Adobe Soundbooth or 
Premiere create are not consistently accurate. Specifically, their transcriptions have problems 
with proper names and nouns. But, what if you just need a transcript RIGHT NOW and are willing 
to trade off some accuracy for blinding speed.

In which case, you are half-way home. Adobe can create the transcripts and export them as XML 
-- except that you can't read them. 

That's where Transcriptize comes in. Here's how.

For this example, I have an interview with Vint Cerf from 2003 talking about how they are 
working to redesign the internet (specifically the TCP/IP protocol) so that it can be used in the 
vast distances of outer space.

In Adobe Soundbooth, I created a transcript and exported it as an XML file. (If you need help in 
learning how to do this, either refer to my book, or watch the tutorials on Adobe TV.) 

http://www.assistedediting.com/Transcriptize/
http://www.amazon.com/Adobe-Production-Premium-Studio-Editors/dp/0240812239
http://www.amazon.com/Adobe-Production-Premium-Studio-Editors/dp/0240812239
http://www.adobe.com/products/creativesuite/production/
http://www.amazon.com/Adobe-Production-Premium-Studio-Editors/dp/0240812239
http://tv.adobe.com/


Here's what the beginning of the XML file looks like. The blue highlighted section is the output for 
the word "what's" that occurs 1.889 seconds into the video. (XML is like reading a book where 
there's only one word on each page.)

After starting Transcriptize, its located in the Applications folder, the opening dialog appears. 



I click Choose Transcription XML and select the XML file containing the exported transcript.



I clicked the Identify Speakers button. This smaller dialog says there are two speakers in this 
transcript. I was one, because I was asking the questions, and Dr. Cerf was the other. This gives 
me a chance to label the different speakers as part of the transcript, something Soundbooth does 
not do.

At this point, we have three output choices - ranging from the cool, to the very cool, to the 
stunning.

* Save Text File. 
* Save Spreadsheet 
* Save as FCP XML file

Saving as a text file puts your text into a standard text file and labels the speakers. The Adobe 
software does not punctuate, nor does it put in paragraphs, so you would need to do that as you 
see fit. The nice thing is that once your XML file is created, it takes only a fraction of a second to 
convert it to a text file.

For the next option, I'm going to slide the Word Grouping slider down to 5. This creates an 
artificial paragraph of five words. (You can drag this to any number you want.)

Saving as a spreadsheet creates an Excel spreadsheet that puts each 5 word phrase on its 
own line, along with the name of the speaker and the time the phrase starts and ends. This 
makes it easy to do a paper edit of your interview. And, because this is Excel, the person 
working with the transcript doesn't need to have Final Cut installed on their system.



But the really stunning part of this software is this. Import the clip you made the transcript of into 
Final Cut Pro. Select the clip in the Browser and choose File > Export > XML. 

Use all the defaults in the Export XML dialog. This exports the XML version of that clip. Keep 
Final Cut running and the project containing this clip open. 

In Transcriptize, click the Choose clip XML button and select the XML file of the clip that you 
just exported. The clip icon appears in the Transcriptize window. At the bottom, click the Add 
Clip Markers button.



In the XML dialog, select the project you want this updated clip to be stored - in our case, we'll 
use the Transcriptize project. 

In almost no time, a new clip is loaded into the Browser with the same name as the original clip. 
But this new clip has a ton of markers associated with it.



When you load that clip into the Viewer, all those clip markers contain the name of the speaker 
and the text of what he is saying at that moment in time! (The number of words of text are 
determined by the setting of the Words slider in Transcriptize.) 

Even better, if you edit that clip into the Timeline, then select Edit > Find, you can find for any 
word contained in the text of a marker!

This means that we can use the power of Soundbooth or Premiere to generate rough transcripts 
in seconds, then integrate these transcripts into either text files, spreadsheets, or our FCP 
workflow almost instantaneously.

As someone who does a lot of work with documentaries, this is an amazingly powerful tool! I 
knew there was a reason we had that party this year...



Note: By the way, I don't make any money on the sales of Transcriptize - but it 
was fun to watch Philip and Greg think about how to create this while munching 
chips in my kitchen....
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INTERESTING INTERVIEWS ON MY BLOG

During my trip to the UK, I had some extra time, between my presentations, to wander the trade 
show floor at the Broadcast Video Expo in Earl's Court, in London. Many of the big players were 
there, of course, but there were lots of products and companies displaying products that I had 
not heard before.

So, I grabbed my tape recorder and did a number of interviews that I think you might like to hear:

Active Storage - Mac-based replacement for Apple's XServe RAID 
Guest: Paul Phillips (TRT: 6:00) 

BinoRig - 3D camera rig for smaller cameras 
Guest: Nick Rose (7:37)

Hocus Products - wireless lens-focus puller for independent film shoots 
Guest: Pete Hoare (TRT: 3:43)

Imagineer Systems - Follow-up to our conversation on mocha. 
Guest: Martin Brennard (TRT: 14:00 )

Object Matrix - a RAID of RAIDs for protected media asset storage and retrieval 
Guest: Nick Pearce (TRT 7:07)

Tools on Air - multi-camera live video production on a Mac 
Guest: Neil Anderson (TRT: 6:20)

If these are the sort of interviews you like, be sure to listen each week to the Digital Production 
Buzz. Subscribe to the show on iTunes and stay current on all the latest news in our industry.
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FORMATTING SCRIPTS FOR VOICE-OVER TALENT

Travis, the voice-over guy, sent out a newsletter recently containing tips for formatting your 
scripts for voice over talent. These were such helpful ideas I asked his permission to reprint them 
here.

Not only will these tips help save you money, but they will allow your talent to give 
a more effective read.

(1) Double Space your script. 

http://www.broadcastvideoexpo.com/
http://www.larryjordan.biz/assets/blog_media/Buzz_Phillips_Paul.mov
http://www.larryjordan.biz/assets/blog_media/Rose_TeleText_Buzz.mov
http://www.larryjordan.biz/assets/blog_media/Buzz_Hoare_Pete.mov
http://www.digitalproductionbuzz.com/BuZZ_Audio/Brennand_M_Buzz_100218.mp3
http://www.digitalproductionbuzz.com/BuZZ_Audio/Pearce_N_Buzz_100225.mp3
http://www.larryjordan.biz/assets/blog_media/Anderson_Tools_100218.mov
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/
http://www.votalent.com/
http://www.votalent.com/


Double spacing allows your talent to make corrections or notes between the lines. 
Double spacing is also easier to read. 

(2) Use a Font With Serifs. 
Fonts come in two basic styles - serif and sans serif. The "serifs" on the Times 
Roman font are there to guide the eye and make the text easier to read. Helvetica 
or Arial fonts (sans serif) are intended to be used as titles. While Helvetica or Arial 
looks cleaner, with a more "graphic" look, it's actually harder to read. This font 
(Times Roman) has serifs. This one (Arial) does not. This is the standard Font for 
Hollywood scripts. -12-point Courier, which is a serif font. 

(3) Write Out Loud. 
Be sure your writer actually speaks the words as they write. Otherwise the words 
will be written for the eye, instead of for the ear. 

(4) Don't write in all caps. 
Many years ago, the teletype machines used in radio and TV stations didn't have 
lower case characters, so the copy that the talent read was always in capital 
letters. As a result, some people mistakenly thought that the scripts were written 
all in uppercase because they were easier to read–a belief that has persisted to 
this day. This is wrong. Capital letters inform the reader that a sentence has 
started, that a particular noun is a proper one, or that a group of words is actually 
a title. 

(5) Be careful with run-on sentences. 
In written text, if a sentence is complicated, we can easily go back and re-read that 
sentence if we don't understand something. That's difficult to do with the spoken 
word. Also, when a sentence is long, your voice talent might need to take a breath 
mid-sentence, which disturbs the flow and the listener's comprehension. Always 
keep your sentences as short and direct as possible.

Thanks, Travis!
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PASSING THOUGHTS

A collection of quick thoughts, notices, and stuff.

SOMETHING NEW IN MY BLOG

I've started a new section in my blog - Film Notes. If you have something you've created that 
you want others to watch, send me a note and I'll post it here.

Larry's Blog: www.larryjordan.biz/blog

SMOOTH SLOW MOTION

Adam Connell sent this in:

mailto:larry@larryjordan.biz?subject=Film note idea
http://www.larryjordan.biz/blog


I would like to share a smooth slow motion effect I figured out. Normally I cut 
1080/25p. From HDV or xdcam source. I wanted to find a very smooth slow 
motion effect to use in a recent project. The interpolation of frame blending in FCP 
never works well for my needs. Particularly doing it with 15 progressive frames. 
Then it dawned on me. 50i is, effectively, 50 interlacing "half" frames. I tried 
shooting ( with my xha1s canon HDV) something I wanted to playback in a smooth 
slow motion in 1080.50i.

Captured onto a 50 sequence. Changed playback speed to 50% without frame 
blending. De interlaced ( select upper field order for canon video, lower field order 
for Sony). Playing this back you will be playing back every frame that was 
originally interlaced in one second over two seconds in progressive. Export this as 
a 25p QuickTime and drop into a 25p sequence where necessary. - what do you 
think?

Larry replies: Cool - definitely worth giving a try.

WHEN 20 FRAMES IS NOT WHAT YOU EXPECT

As we move into the world of faster frame rates with HD, keep in mind that when you set a 20 
frame dissolve, the actual time of the dissolve will vary depending upon the frame rate of your 
video. 

This seems obvious, but I keep forgetting this when I start editing HD.

�●     Thus 20 frames in NTSC is 2/3 of a second (20/30 fps)
�●     In PAL, it is almost a full second (20/25 fps)
�●     In 60 fps HD, it's only 1/3 of a second (20/60 fps)

You get the idea. Just giving you a heads-up.

TWO NEW GOODIES ON KEN STONE THIS WEEK

As Mike Horton likes to say, "If you haven't discovered Ken Stone's website, you haven't been 
paying attention." Here's the latest from Ken as I go to press. 

1) Experimenting with 3D in FCP - by Eric Cosh.

"Several months ago, I decided to check out the 3D situation and was surprised to 
find that there were several Indie filmmakers who had dappled into the 3D test 
arena. Most of what I've seen is pretty amateurish, but at least it did show it could 
be done on at least the 'consumer level'. I decided it just might be cool to put 
together an article and some video in 3D as an experiment."

http://www.kenstone.net/fcp_homepage/experimenting_with_3d_cosh.html

2) Wi-Fire by David A. Saraceno

"Internet access is becoming essential in today’s world, particularly if you travel 
with your laptop. Accessing email, web pages, or uploading images or video to 

http://www.kenstone.net/
http://www.kenstone.net/fcp_homepage/experimenting_with_3d_cosh.html


sharing sites depends on an available Wi-Fi hotspot or network. Some networks 
may exist nearby, but their signals may too weak to be identified and accessed by 
your built in laptop Wi-Fi card."

http://www.kenstone.net/fcp_homepage/wi_fire_saraceno.html

WORKING WITH THE CANON DSLRS

JH Fleming sent this in:

An audio tweak for Canon 5D and 7D cameras - from Gearslutz.com 
 
www.gearslutz.com/board/post-production-forum/458971-audio-tweak-canon-5d-
7d-cameras.html

USING SPEED TOOLS

Don Smith writes:

I solved a problem syncing a video demo to narration where each was recorded 
separately and didn't sync naturally.

I did it using Speed Tools in a way i've not seen before. Here's a quickie demo of 
my method on YouTube: 

http://www.youtube.com/watch?v=hTeuVKk-NLI

[ Go to Top. ] 

CRUMPLEPOP RELEASES NEW FCP FLIPPER FILTER

CrumplePop has a new flipper filter. This can quickly and easily flip logos, text, photos, and video 
clips, all with a simple drag and drop operation. 

Find out more here: http://www.crumplepop.com/
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READER MAIL

STUCK WITH THUMBNAILS

Cary asks:

http://www.kenstone.net/fcp_homepage/wi_fire_saraceno.html
http://www.gearslutz.com/board/post-production-forum/458971-audio-tweak-canon-5d-7d-cameras.html
http://www.gearslutz.com/board/post-production-forum/458971-audio-tweak-canon-5d-7d-cameras.html
http://www.youtube.com/watch?v=hTeuVKk-NLI
http://www.crumplepop.com/


I recently opened FCP and the Browser window was filled with pictures. Help!

Larry replies: Control-click in the gray area of the Name column in the Browser - where your 
cursor is in the screen shot you sent - and select View as List.
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SETTING UP FILES FOR A DVD

Radim Spetlik asks:

How do you organize your files when creating videos in FCP for a DVD?

Larry replies: Radim, thanks for writing!

For me, there are two steps:

* Creating the original files for the DVD 
* Creating the DVD

Here's an article that describes how I set up my hard disks:

http://www.larryjordan.biz/articles/lj_archive.html

Here's an article that describes file naming and other organizational stuff:

http://www.larryjordan.biz/articles/lj_filenaming.html

Then, here's how I set up my project files. Notice - one folder for the whole project, sub-folders 
for different elements.

Main Project Folder

FCP Source Files Folder

Final audio mix 
Graphics folder 
Motion projects folder 
Projects folder  
STP Projects folder 

DVD Files Folder

Menus folder 
Tracks folder 
Slides folder 
DVD-ROM folder  
Build folder

There are lots of other ways to do this, but this system works for me. 

http://www.larryjordan.biz/articles/lj_archive.html
http://www.larryjordan.biz/articles/lj_filenaming.html
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CAPTURING TO PRORES

Tom Step writes:&

I'm trying to figure out how to capture directly from BetaSP via AJA IO into ProRes 
HQ for a client. We have both FCP 5 and 6. There's no preset for capturing to it 
(HDV to ProRes HQ is the only option and not applicable). SO capture in 
uncompressed 10-bit and then put it into a ProRes HQ sequence and make a QT 
with current settings OR put it into Compressor? 

Either way seems twice as long as it should be... am I missing something?

Larry replies: Tom, thanks for writing.

First, ProRes is only supported on FCP 6 or later, so you will need to upgrade your FCP 5 
system. 

However, you are correct, there's no prebuilt Easy Setup for this workflow. Instead, you need to 
create a custom setup using Final Cut Pro > Audio/Video settings > Capture settings tab.

Once you have this configured, go to the bottom of the window and select Save As Easy Setup 
which will allow you to reuse this setting as many times as you need.
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DEALING WITH DROPPED FRAMES

Rick White asks:

I am experiencing a problem in Final Cut 6.0. I have 130 pictures in a sequence 
with a music track and some sound effects to create a slide show. During playback 
I am getting a dropped frames notification. I have two hard drives. The pictures are 
in the My Pictures folder on the boot drive. I do not have any captured video so all 
the assets are on the boot drive. The interesting thing is I only started 
experiencing the problem after I added some sound effects from Soundtrack Pro. 
Each of the pictures are jpeg and 2300 x 1700. 

Larry replies: Rick, thanks for writing. 

The key issue is not where your pictures are stored, but where your render files are stored. This 
is a symptom of a hard disk that's too slow. Make SURE all scratch disks are set to an external 
drive.

Also, the video format you use for your sequence will have an affect as well. Here's an article 
that explains video formats in more detail.

http://www.larryjordan.biz/articles/lj_video_data_rates.html

http://www.larryjordan.biz/articles/lj_video_data_rates.html
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CONVERTING NTSC TO PAL OR PAL TO NTSC

Ben King and I were talking about the best way to convert between formats recently. Since Ben 
is from the UK, he has more experience with this than I do, so he sent me this note as a follow-
up:

There are lots of ways to convert media without, essentially, changing size:

�●     PAL to NTSC
�●     25 frames per second to 29.97
�●     25 fps to 24 frames per second or 23.98 (23.976)
�●     NTSC or HD 23.98 to 25 fps PAL or HD

You have four options:

1.  Buy a Snell & Wilcox Alchemist PHc (looks great, costs a fortune)
2.  Go to a post house that owns a Snell & Wilcox and get it done there.
3.  Use Graeme Nattress' Standard Converter, its software but works great 

(www.nattress.com)
4.  If you are going to a 24/23.98 to a 25 fps or visa versa you can use Cinema 

Tools to Conform a frame-for-frame copy.

The main thing to make sure outside of this technique is that your output 
resolution and field interpolation is correct for the format you are using to master, 
but this is (usually) as simple as dropping a converted clip on to the timeline.

Larry replies: Thanks, Ben, for the update.
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SAVING MULTIPLE SCENES INDIVIDUALLY

Jim Mitchell asks:

I am progressing through the archiving process of clips we talked about and it is 
tedious and so time consuming that I often forget what I'm doing and why I am 
doing it.

Imagine if you will 50 - 100 scenes in the browser. You want to break each scene 
up into a unique clip and then save all the clips individually. Is there any way using 
FCP 6 or 7 that you can drop all these scenes (CLIPS) to the timeline, audio/video 
sweeten them and then (save) output them as individual clips all at once? In-other-
words, can they be somehow marked in/out for each clip on the timeline and then 
exported as individual clips and not as one big file with several clips?

Currently, I'm doing it one clip at a time and it's going slower than watching grass 
grow. Makes me want to fire up the old serial GVG linear edit system again.

Larry replies: Watching grass grow should only be done on holiday. In this case, check into File 



> Batch Export, inside Final Cut. It will do everything you are doing now, except faster and in 
batches.
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GETTING EXTERNAL VIDEO OUTPUT TO WORK

Trent Anderson writes:

I am running the latest edition of FCP 7.0.1 on my MacPro with Snow Leopard. 
The computer is connected via FireWire to a Sony DSR 11 Deck, and then out to 
an NTSC monitor.

Suddenly, when I played the clip again in the timeline, it will NOT play back 
through the deck and out to the monitor. So, I thought maybe something was 
wrong with the deck, so I put a tape in it, and opened Log & Capture, and voila...! I 
was able not only to log and capture, but I could see it and hear it on the external 
monitor. I also changed the firewire cable. 
 
However, as soon as I closed Log & Capture window, the images would no long 
be visible and would not output to the external monitor, speakers, etc.

Larry replies: Trent, thanks for writing. External monitor output is controlled from the View menu. 
Specifically: 

�●     Make sure View > External Video is set to All Frames.
�●     Make sure View > Video playback is set to your DSR-11 by selecting the Apple Firewire 

NTSC (720 x 480) setting.
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RECORDING LIVE WITH FINAL CUT PRO

Nathan Ansell writes:

My name is Nathan Ansell and I am the Media Producer/Director at First Family 
Church. I was searching for the best way to record live using FCP.

We record Sunday Services in SD 24 fps and other services and projects in HD 24 
fps. In order to speed up the process I want to start capturing live on our Mac Pro. 
I've tried running fire wire cable, but that failed to capture.

I would like to capture live from our Edirol V-8 video board by Roland. This board 
only has BNC connection OUT. I would like to get a board that has VGA out since 
all our cables to our projectors are VGA and we lose quality from the Computer 
Outputs. Any suggestions for a solution on that?

Larry replies: Nathan, thanks for writing.

Capturing live video requires:



* A fast hard disk 
* A way to connect the video cable to the computer 
* Reasonably current version of Final Cut Pro and the Operating system.

Some HDV cameras don't support output from the camera while the camera is shooting using 
FireWire. But they DO support it using the video output.

Also, Mac Pros and G-5 Towers are much better for this than laptops.

Assuming you just want to capture, look into AJA Kona 3 or Blackmagic Design Decklink capture 
cards. Send the video feed from your switcher (via BNC) or your camera to the card and you can 
capture live.

An even BETTER alternative is to be able to capture and start editing before the capture is 
complete. That requires a Telestream Pipeline box. This allows you to capture live video, and 
edit it while the service is still going on.

The best output from your switcher is SDI, or HD-SDI if you are shooting and switching in HD. In 
descending order of quality, the other SD options are: Component, S-Video, and Composite. The 
problem isn't the BNC connector but the video signal it is carrying. 

Also, check into a brand new product called Tools on Air that just launched in Europe. That could 
put an entire production studio on your Mac.

UPDATE - FEB. 28, 2010

Ben Balser writes:

In the recent newsletter, RECORDING LIVE WITH FINAL CUT PRO with Nathan 
Ansell, you recommend the AJA Kona 3 card. I'd like to point out that there are 
actually three different cards in the Kona line, and the "3" is not always the card 
folks should get. I have a fairly nice sized studio as a client who put in Kona 3 
cards (before I became involved with them) in their edit bays. Problem is, they also 
got Yamaha sound mixers that require audio XLR inputs. The Kona 3 only has 
digital outputs. Thus, they now have to purchase a third piece of hardware, an 
audio digital to analog converter. If they had gone with the Kona LHi or LHe card, 
they would have the audio analog In/Out's they need, without having to purchase 
extra hardware. So, I wanted to share this, in hopes that someone doesn't dive 
into the Kona 3 when they need audio analog In/Out's, and invest in one of the 
other two cards in the Kona series.

Another draw back is that the Kona 3 card causes some audio delay when going 
out to an audio Firewire device. I'm hoping AJA addresses this soon.

In fact, this Tuseday (3/2/10) is the S. LA. FCPUG's 3rd anniversary, and our 
corporate sponsor (AJA) has given us a Kona LHi card as a raffle prize. I use one 
in my own studio (because I need the audio analog In/Out's) and love it.

Larry replies: Thanks, Ben. 

[ Go to Top. ] 

CREATING 16:9 FROM 4:3 MATERIAL

http://www.toolsonair.com/


Bob Lutjen asks:

I have a put together a sequence of video clips in final cut,,, they are all shot on a 
DVX-100 and are all 4:3. I was just told that i need to give someone a 16:9 version 
of this sequence. I've been trying to change the settings and then export a 
quicktime movie to see what kind of results i get and I'm never happy with the 
look.... Could you tell me what you would recommend for best results.

Larry replies: Bob, There is no easy way to get there, because if you don't want pillar-boxing 
(black bars on the side of your video to fill the frame), you'll need to lose part of your image to get 
this to fit.

�●     Try creating a new DV sequence that's 16:9.
�●     Drop your 4:3 clip or sequence into it.
�●     Load the clip or sequence from the Timeline into the viewer, go to the Motion tab and 

adjust scale until the image fills the frame from side to side.

That's about the best you can do -- the larger you make the image, the softer and grainier it will 
look.

[ Go to Top. ] 

GETTING FASTER RENDER SPEEDS

Alex Melli asks:

What can I do to get faster renders in FCP?

Larry replies: Alex, RENDER speeds in FCP are totally processor-dependent. Worse, FCP 
doesn't use all your processors, it only uses one (and a half.) Render speeds probably won't 
increase until the next version of FCP is released -- whenever that is.

[ Go to Top. ] 

STOPPING FCP FROM STARTING UP AT START-UP

Konrad Mronczek writes:

When I start up my machine, the FCP starts immediately without clicking on FCP 
icon, can you tell me what cause that strange behavior. I tried to find solution in 
"User Preferences" but I didn't.

Larry replies: Konrad, go to the Black Apple logo > System Preferences > Accounts. Click the 
Login items tab and remove Final Cut from the list.

Its the OS that's starting FCP, not FCP itself.

[ Go to Top. ] 



UNDERSTANDING SETTINGS

James Dunn writes:

I have a question area pertaining to sequence settings. I am still in Studio 1, and 
am primarily using FC to produce narrated slideshow type personal stories (music, 
still photos, narration) which is a new direction for me relative to selling services to 
families.

The one area where I am constantly finding myself stuck is in understanding the 
correct sequence and compression settings. I recall that you covered parts of that 
in your training.

Can you point me to a tutorial or primer that would help clarify the basics that I 
need to know? 

Larry replies: James, this gets very confusing!

First, you need to separate the settings you use for editing from the settings you use for 
compression and final delivery. They are NEVER the same.

Since you are outputting for the web and DVD, and you are using FCS 1, your editing settings 
are easy. From within Final Cut Pro, go to Final Cut Pro > Easy Setup and select either DV 
NTSC or DV NTSC Widescreen.

Then edit your project.

Export your project using File > Export > QuickTime Movie and be sure Settings is set to 
Current Settings.

That handles the editing part in Final Cut Pro. 

When it comes to DVDs, all DVDs are SD, not HD. So, you need to compress your exported 
movie into something a DVD can play. You do this using Compressor.

Import your file into Compressor. Then, since the total of all the video on your DVD runs less 
than 90 minutes, apply a compression setting of MPEG-2 (or DVD) 90 minute Best Quality and 
compress your project.

Compressor is smart enough to figure out the difference between 4:3 and 16:9 automatically.

This handles the compression part to create a DVD.

Finally, import the compressed video files into DVD SP and create your DVD.

For Flash movies, you will need to buy other compression software as Final Cut Studio does not 
create Flash or WMV files. Adobe Media Encoder or Telestream Episode or DV Kitchen are good 
programs to check into. 

As far as your image size goes, most people prefer images which fill the frame, instead of black 
wrap-arounds. However, this is a personal choice, and you can pick what you like. For more 
details on images and aspect ratios, read this article:

http://www.larryjordan.biz/articles/lj_grfx_look.html

http://www.larryjordan.biz/articles/lj_grfx_look.html


Jim then wrote back:

I’ve practiced most of this evening with your suggestions and am making some 
headway. The original problem was that I had put together a slide show in FC and 
had selected some HD settings and the Apple Intermediate compressor. The 
resulting piece was a lot larger than I had anticipated, especially for the web. Your 
reminder of the Easy Setup, well, thank you for that...

On my FCS 1, in Easy Setup, I find the DV NTSC, but not the Widescreen option. 
However, I do see DV NTSC-Anamorphic ...would that be the same as 
widescreen? Otherwise, is the 16:9 box more for style of the presentation when 
cropping images?

I’ve attached a PNG screen shot, which displays what my default is when I do the 
DV NTSC: 720x480 DV NTSC 3:2

I am still not clear about the 3:2 aspect versus the 4:3 (my guess is that 720x480 
is more desirable for the wider presentation style that I seem to gravitate towards).

Larry replies: Remember -- large file sizes do NOT necessarily equate to large files on the web. 
There is a correlation but MUCH less than you might expect. The reasons are far too complex to 
go into in an email.

Yes, DV NTSC Anamorphic is 16:9. Apple changed the wording in later versions.

DV is 3:2 because it uses rectangular pixels. The same video on the web will be 4:3 because it 
uses square pixels. Understanding this will cause your brains to explode. You can either study 
this and understand it -- or accept that it's just magic and move on. After studying this, I 
understand it - but still lean to the "its magic" point of view.

FIRST - you need to decide if you are creating 4:3 or 16:9 sequences. Everything hinges on that 
decision. Since you are using stills, it is totally aesthetic - but you need to decide this first as it 
affects the rest of your workflow.

Once you decide on an aspect ratio, if you are using 4:3, Compressor will create images that are 
640 x 480 (remember -- "its magic.") If you are using 16:9, Compressor will create images that 
are 720 x 405 -- OR -- 640 x 360. Either set of numbers works.

When it comes to compression, you should select the setting for Apple TV, if it exists, for posting 
to the web and DVD 90 minute High-Quality for use in DVDs.

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this newsletter. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week. In fact, email me on how you can put the free BuZZ 
player on your website! 

�●     Visit our store and buy a mousepad - your mouse deserves it. 

http://www.digitalproductionbuzz.com/LiveThisWeek
mailto:larry@larryjordan.biz?subject=FREE BuZZ Player
mailto:larry@larryjordan.biz?subject=FREE BuZZ Player
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162


�●     Or, check out our current Final Cut Studio tutorials. 

Also, please continue sending me your comments and questions. I love hearing from you and 
enjoy the conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 2.2 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2010 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr65.pdf
http://www.larryjordan.biz/nxlttrs.html
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